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Introduction 

Welcome 
ZebraDesigner software is a family of labeling software products that brings a complete bar 
code printing solution to desktop users. ZebraDesigner offers an easy-to-use interface and 
meets any label design and printing requirement for efficient label printing solutions to users 
in retail, logistics, health care, chemical, automotive, and other industries. 

ZebraDesigner can be used with any 32-bit Windows® operating system: Windows 98 SE, 
Windows NT 4.0, Windows ME, Windows 2000, Windows XP, and Windows Server 2003. 

Contents of the package 
Before starting the installation of ZebraDesigner software, check the contents of the package 
to ensure it is complete. The package includes: 

• ZebraDesigner CD 

• Software key on a sticker or hardware key (not available with all editions) 

If any of the mentioned items are missing, please contact your software vendor immediately 
for package replacement. 

About this Manual 

About this Manual 

The ZebraDesigner Pro User Guide helps you design and print labels quickly. 

The User Guide contains the following sections: 

Introduction: This chapter will introduce you to ZebraDesigner Pro. 

Installation and Activation: This chapter will show you how to install and activate the 
labeling software. 

Setting up ZebraDesigner software: This chapter will show you how to set up and 
customize software to your preferences. 

Designing Labels: This chapter will show you how to create labels. You should refer to this 
chapter regularly while designing labels, until you have completely familiarized yourself with 
the commands. By using the information contained in this chapter, you will able to use 
labeling software quickly and efficiently. 
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Printing and Previewing Labels: This chapter will show you how to print and preview 
labels. 

Interface Reference: This chapter describes details and explains all the commands used in 
the labeling software. 

Technical Support: This chapter provides information on how to contact technical support. 

Software Restrictions 

All features explained in the document are available in the ZebraDesigner Pro edition; 
however, some features are not available in the ZebraDesigner edition. 

Sections discussing features not available with ZebraDesigner Pro will display a note. 

Typographical Conventions 

• Text that appears in bold refers to menu names, file names (SETUP.EXE), interface 
buttons (OK), PC keyboard keys (Alt), and menu flows; menu flows have a > that 
separates one menu to the next menu (Start > Programs > ZebraDesigner Pro).  

• Text that appears in italic refers to confirming actions, identifies graphic captions, 
identifies text that you need to type, and locations such as Folder. 

• This icon identifies the features that are only available in ZebraDesigner Pro. 
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Installation and Activation 

System and Software Requirements 

ZebraDesigner Editions 

To run ZebraDesigner, you need at least the following: 

• Pentium-based computer with at least 64 MB of RAM. 

• One of these 32-bit Windows operating systems: Microsoft® Windows® 98 SE, ME, 
NT, 2000, XP, or 2003. 

• Hard disk with 100 MB of free disk space. 

• CD-ROM drive. 

• Support for OLE DB database drivers. Recent Windows operating systems have 
included OLE DB database drivers. If your operation system does not have the 
database support, the installation wizard prompts you to install it. 

• Administrator rights to the local computer during installation. 

Installing Software 

Install ZebraDesigner Pro 

When you put the ZebraDesigner Pro CD in your CD-ROM drive, the 
installation/demonstration program automatically starts. You can browse the directory of the 
CD and look at the brochures, technical documentation, sample files, and other documents. 

Note: If you are using Windows NT, 2000, XP, or 2003, you have to log on with 
Administrator rights perform installation. 
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Run Installation 

Use the installation wizard to install ZebraDesigner Pro on your desktop PC.  

To install the software, do the following: 

1. Put the ZebraDesigner Pro CD in your CD-ROM drive. An installation window 
automatically opens. 

Note: If the installation wizard does not start automatically, go to the main CD directory 
of your ZebraDesigner Pro CD and double-click the file START.EXE. 

2. Click Install. A new window opens showing all ZebraDesigner editions 

3. Click on the version of ZebraDesigner that you want to install, and follow the 
prompts. 

Close All Software Applications 

To ensure complete installation of ZebraDesigner Pro, close all open software applications 
before you start installing ZebraDesigner Pro. 

Define Setup Options 

To continue installation, do the following: 

1. Click the Next button. 

2. Specify the program group you want to use for ZebraDesigner Pro. 

3. Specify if shortcuts to ZebraDesigner Pro should be created on the desktop or in the 
Quick Launch area. 

4. To finish installation, click the Install button. 
 
After installation you will be asked to install a printer driver. It is necessary to install a 
ZebraDesigner driver. If you do not install a printer driver while installing the 
software, you will be asked to install one the first time you run the program. 

5. Once the installation is complete, the Start menu in Windows shows a new program 
group for ZebraDesigner Pro that contains shortcuts for all ZebraDesigner Pro 
applications. 

Install Printer Driver 

To install the ZebraDesigner printer driver on your computer, do the following: 

1. Click Start > Programs > ZebraDesigner Pro. 

2. In the group ZebraDesigner Pro, click the shortcut Add printer. 

3. The printer installation wizard starts. 

4. Follow the onscreen instructions. 
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Register ZebraDesigner Pro 
Activate ZebraDesigner Pro to obtain all features. If you do not complete the activation 
process, ZebraDesigner Pro only runs in DEMO mode. 

Note: ZebraDesigner does not require registration. It is free software, but available with 
less functionality than ZebraDesigner Pro. 

To register the software, do the following: 

1. Start ZebraDesigner Pro. 
The DEMO dialog box appears. 

2. Click the Register button. 

3. Enter the required information and follow the prompts. 

Demo Mode 
ZebraDesigner Pro running in the DEMO mode has limited functionality. The major 
limitations of the ZebraDesigner Pro DEMO mode are: 

• All e characters in the text objects are replaced by Z characters. 

• Graphic images are printed with DEMO text written over them 

You should use the DEMO version only to evaluate the software. Any commercial use of the 
DEMO software is prohibited. To obtain the full working version of ZebraDesigner Pro, you 
must purchase and register the software. 
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Setting Up ZebraDesigner Software 

User Interface 

Main Window 

This is the ZebraDesigner Pro main window. 

 
 

Mouse Wheel support 

If you have a mouse that has a wheel in place of the middle button, you can use it to speedup 
zooming and scrolling: 

• Turning the wheel scrolls the label up or down. 

• Holding Shift and turning the wheel scrolls the label left or right. 

• Holding Ctrl and turning the wheel zooms the label in or out. 
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Shortcuts 

Delete Deletes selected object 

Ctrl + X Cut 

Ctrl + C Copy 

Ctrl + V Paste 

Alt + Backspace Undo 

+ (on numeric pad) Zoom In 

- (on numeric pad) Zoom Out 

Alt + Shift + Backspace Redo 

Ctrl + T Rotate 90° 

Ctrl + A Align 

Ctrl + Z Undo 

Ctrl + Y Redo 

Ctrl + N New 

Ctrl + O Open 

Ctrl + S Save 

Ctrl + P Print 

Ctrl + R Print preview 

Ctrl + move the object with 
mouse 

Parallel moving of the object by main axes only 

Alt + move the object with 
mouse 

Objects snap to grid even if it is off 

Ctrl + move the object with 
cursor keys 

Fine tuning the position of the object 

Shift + cursor keys Fine tuning the dimensions of the object, resize width 
and height in very small steps 

Right-clicking the object Opens pop-up menu with shortcuts to commands. The 
content of the pop-up menu depends on where you 
clicked your mouse button and what was selected at 
that time 

Enter 
F2 or 
double-click 

Opens properties dialog box of the selected element 



ZebraDesigner Pro User Guide 

8 

Using the Keyboard and Mouse Effectively 

When selecting objects, you can use the Ctrl key to adjust object's anchoring point by 
clicking the object placeholders. 

If you have a Wheel Mouse, you can use the wheel to scroll the label up and down. Holding 
Ctrl when rotating the wheel adjusts zoom factor, and Shift scrolls the label left or right. 

Double-click on printer's name in status bar to open printer properties dialog box in which 
you can set various options for currently selected printer. If you hold Ctrl while double-
clicking, the printer setup dialog box is opens, and you can select a different printer. 

You can quickly move objects from one open label to another by dragging the desired object 
to another window while holding Alt. If you want to copy objects instead, hold both Alt and 
Ctrl. Note that you must have both label windows visible to do that. 

You can select different objects on a label using the Tab and Shift +Tab keys. 

Pressing the cursor keys while holding the Ctrl key can move the selected object. You can 
use this to fine-tune the position of the object. Holding Shift while pressing cursor keys will 
resize the object. 

You can use the right mouse button almost anywhere on the label to access the most common 
options for that area/object. For example, if you click an object with the right mouse button, a 
pop-up menu appears that contains options and actions that can be performed on the selected 
object. Similarly clicking other parts of the label produces pop-up menus with options for that 
part of the label. 

You can select multiple objects by holding Shift while clicking them. 

Use the element shortcuts in toolbars whenever possible. Each label element that can be 
connected to some Contents Provider has a shortcut enabled to quickly access existing 
variables or define new ones. Click the element's shortcut handle, shown as a small arrow by 
the side of some toolbox icons. 
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System folder 
The labeling application uses its system folder for storing files needed to run the program. 
The location of the folder varies depending on the Windows operating system used. 

On Windows 9X and Me, the location is C:\Program Files\ZebraDesigner Pro\Bin\System. 
On Windows NT, 2000, XP, the location is C:\Documents and Settings\All 
Users\Application Data\Zebra\ZebraDesigner Pro. 

It is important to own the write access to this folder on your computer system and the right to 
write to and modify files in this folder. 

In these files, user data and user rights are stored, as well as custom settings, variable trace 
logs, label usage logs, variable definition files *.NVR, bar code standards, and file names 
GLOBALS.TDB. It also stores the values of global variables. 

You should design the appropriate folder layout on disk for your label projects. You can 
increase your work efficiency if you always know where certain types of files are stored. The 
application also finds required elements faster this way. This is important with more 
demanding labels, which intensively use databases, pictures, and forms. Make a separate 
folder for each project you are building, e.g. Project1. Beneath this folder make subfolders 
Database (for databases), Forms (for forms) and Labels (for labels). Store appropriate files in 
each of these subfolders. 

Welcome Wizard 
When you start the labeling software, a Welcome Wizard will appear. It provides a quick 
access to most-used commands when starting working on a label layout. 

Create a new label A blank label will appear and Label Setup Wizard will start. You 
can then design a new label from a scratch. 

Open recently used 
label 

A list of recently used labels will appear to provide a quick access 
to commonly used labels. 

Open some other 
existing label 

A common Windows dialog box opens to let you browse for the 
appropriate label file. 
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Designing Labels 

Using Label Setup Wizard 

Use Label Setup Wizard 

With the Label Setup Wizard you can define the dimensions of the label and change printer 
setup. It consists of a few simple steps.  

Select a Printer 

 
Label setup Wizard - Selecting printer 

If you want to set the printer parameters, select the desired printer, and click the Properties 
button. The print setup dialog box appears, allowing you to set the printer parameters such as 
print speed, print darkness, and print direction.  

Note that this is a standard Widows printer setup dialog box and its options may differ 
from printer to printer because it is based on the printer driver. 

If the check box Always use default printer is checked, the default window's printer and its 
settings will always be used when opening this label. 

To continue, click the Next button. 
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Select the Label Stock 

 
Label setup Wizard - selecting Label Stock 

If you use one of the standard predefined label formats, you can specify it here. 

Stock Type: Select the type of stock. 

Stock name: Select the stock from the list. 

Stock information: The information about label dimensions, printer settings, and background 
images as defined by the selected stock. 

Label linked to stock: If you enable this option, you cannot change the dimensions of the 
label, because the stock locks the dimensions. 

Note: Using pre-defined stocks simplifies the process of label creation because you do 
not have to define the label dimensions manually. 

To continue, click the Next button. 
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Define the Page Size 

 
Label setup Wizard - choosing Label Dimensions 

Select the page size for your labels. This step is only necessary for office printers. 

Automatic Sizing: Click this option, if you are using a printer with ZebraDesigner printer 
drivers. ZebraDesigner Pro and ZebraDesigner printer drivers will automatically size the label 
dimensions. 

To continue, click the Next button. 
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Select the Label Orientation 

 
Selecting label layout 

Orientation: Select the label orientation. Look at the screen and printer layouts to see how 
the label will be printed from the printer. 

Print directions: Click the Rotated option to rotate the label 180 degrees, when printed. 

To continue, click the Next button. 
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Define the Label Dimensions 

Enter the label dimensions in this dialog box. 

Note:  If you selected the label stock in the previous step, the values for dimensions are 
entered automatically. 

 
Label setup Wizard - defining the label format 

Width, height: Define the label dimensions. 

Margins: Define the label margins. 

Rows, columns: Define the number of labels in horizontal and vertical directions. This option 
is commonly used with office printers. 

Gaps: Define the gap between the labels. 

Note: Define gaps only if you changed the rows and columns options. If you have rolls 
of labels, the gaps between the labels are auto-identified by the gap sensor in the printer. 

Unit of measure: Change the unit of measure you want to use. 

When you are satisfied with the label dimensions, click the Finish button to close the Label 
setup wizard. 
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Designing a Basic Label 

Overview 

In this section you will learn how to design a simple label file with fixed and variable objects. 
The variable objects get values from several sources. You will learn how to: 

• Provide object values with a keyboard prompt. 

• Obtain object values from a database.  

• Preview the label on the screen. 

• Print the label. 

The label you create will look like this: 

 
Basic label 

Create a Basic Label 

To create a basic label, do the following: 

1. Open ZebraDesigner Pro or ZebraDesigner. 

2. From the File menu, select New label or click the  button in the Standard 
Toolbar. 

Each time you create a new label, a Label Setup Wizard will start to help you set up the label 
and connect to the printer. 

Note: You can leave the Wizard at any time and accept the default settings for the label 
by clicking the Finish button. 
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Select a Printer 

1. Select the printer you want to use for label printing. 

Note: If you don’t find your printer on the list, see Install Printer Driver for 
installation instructions. 

 
Selecting a printer 

2. Click the Next button.  
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Define Label and Page Dimensions 

1. If you want to use the label stock, select your choices in the Select Stock window.  

2. Click the Next button. A new window opens to define the label dimensions manually. 

3. Leave the Page Size option at User defined default and check Automatic Sizing.  

4. Click the Next button. A new window opens. 

5. Select label orientation and print direction.  

  

Selecting label layout 

6. Click the Next button. A new window opens. 

7. Enter 10 for label width and 7 for label height. 

Note: Dialog box differs for thermal and office printers.  
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Defining label dimensions 

Note: To change the unit of measure from centimeters to inches or other supported 
units, click on the button with unit of measure below the label preview in the dialog 
box. 

8. Click the Finish button. New empty label opens. 

Enter Non-Changing Text 

1. Click the  button in the Toolbox. The text cursor appears on the 
screen. 

 
Cursor for text object 

2. Move the cursor to the location on the label where you want to place the text object 
and click the mouse button. 
The dialog box with object properties opens. 

3. Type SAMPLE and click the Finish button. 
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Entering content for text object 

4. Click on the text object to select the object. 

5. Using the Text Toolbar, change the font for the text object. 
Choose Arial font, 28 point size, and bold style. 

  

Using format options in the text toolbox 

6. To change the position and size of the text object, select the text object and drag the 
object with your mouse to the position you want it. 
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The screen should show the following: 

 
The text object is placed on the label 

Insert Bar Codes 

Now you will add a non-changeable Code128 bar code on the label. 

1. To insert the bar code, click the button in the Toolbox. 

2. Move the cursor to the desired position on the label and click the mouse button. The 
dialog box with object properties will open. 

3. Enter the value 1234567890 for the bar code contents. 

4. Click the Define button. Edit Bar Code dialog box opens. 

5. Make sure you select bar code Code128 and click the OK button. 

 
Selecting bar code type 
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6. To return to the label, click the Finish button. 

7. Change the position of the bar code by selecting the bar code and dragging it to the 
desired position. 

8. Change the object size by dragging the object handles. The handles are small 
rectangles surrounding the object when it is selected. 

The label should now show the following: 

 
Label with text and bar code objects 

Insert Pictures 

The ZebraDesigner Pro works with BMP, PCX, GIF, WMF, JPEG and many other popular 
graphic formats. 

1. To insert the picture, click on the  button in the Toolbox. 

2. Move the cursor to the desired position on the label and click the mouse button. 

3. The Open dialog box will open allowing you to browse for a picture on your hard 
drive. Go to the folder Sample Graphics and select the picture LEISURE.WMF.  

4. Click the Open button. 

The screen should show the following: 

 
Label with text, bar code, and picture objects 
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Save a Label 

Always save your label during the design process.  

To save a label, do the following:  

1. Click the  button. 

2. Type in the name of the label. For example, type label for the name of the label. 
The name of the label appears in the program caption. 

Use Alignment Tools 

You have placed the objects on the label. Now you want to make sure they are aligned on the 
horizontal center of the label. You can align objects on the label by using the Align Toolbar 
on the right side of the working window. 

To align objects on the label, do the following: 

1. In the Toolbox, choose a select arrow and draw a frame around all objects to select all 
objects. 

Note: The first object you select determines the alignment orientation for all selected 
objects. 

 
Selecting the objects on the label 

2. To arrange the objects, in the Align Toolbar on the right, click the  button. 
The selected objects will be rearranged and positioned on the horizontal center on the 
label. 

Note: 
 
• The Align Toolbar has other alignment commands available in the Align Toolbar. 
 
• You can also align the objects to the label grid. The option Snap to Grid is available in 
the View menu. 
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Use Drawing Tools 

Now you will insert a line to separate a text object from other objects and a rectangle around 
the picture object. 

1. From the Toolbox, select the  button and move the cursor to the 
required starting point of the line. 

2. While drawing the line, press and hold down the mouse button. Move the mouse to the 
end position of the line and release the button. The Line object is placed on the label. 

3. In the Toolbox, click the  button and point the mouse to the upper left 
corner of the picture. 

4. While you stretch the rectangle to the lower right corner of the picture, click and hold 
the mouse button. 

5. To change the thickness of the vertical and horizontal line, double-click on the 
rectangle object to open its properties. Select the thickness you want and click the 
Finish button. 

6. To edit the drawing object, double-click on the line or rectangle to open the dialog box 
with its properties. 

The label should show the following: 

 
Label with fixed objects 

Add Variable Fields 

Overview 

You may want to print a label on which the data changes for each label. ZebraDesigner Pro 
offers different variable fields (counters, date/time fields, operator's input from the keyboard) 
that you can use with text, graphics, and bar code objects. 

For this example, a new label was created. The steps in the following topics explain how to 
create a label that contains a prompted field, a counter, and date/time fields.  
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The captions in the following screenshots were added separately. 

 
The left label shows design mode; the right two labels are two consecutive labels from print 
preview 

Create Keyboard Entry Variable Fields 

The content of a prompted field can be different for every print job. Before you print the label, 
you enter the value for the field. 

1. To display a list of available variable types, click the small arrow next to the 

 button in the Toolbox. 

2. From the list, select New Keyboard Input and click on the label where you want to 
position the object. 
  

A dialog box with the Variable Wizard opens. 

 
Creating new keyboard input variable field 

3. Type Enter product name for the option. Display this text to the print operator. 

4. Click the Finish button. The cursor changes to an arrow with a text object.  

5. Click on the label where you want to position the prompted field. 

The text object is placed on the label and linked to the new variable. 

Note: When you print the label, you are prompted to enter the product name, which is 
shown in preview on the label and on the printed label. 
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Create Serialized Data Variable Fields (Counters) 

Now create a counter field on the label. The value of that variable field automatically 
increases by one on every label. 

1. To display a list of available variable types, click the arrow in the 

 button in the Toolbox. 

2. Select New Counter from the list. 

A dialog box with counter properties opens. 

 
Creating new counter variable field 

Leave everything as default so that the counter will always start from 1 and increase by 
one on each label.  

3. Click the Finish button. 

4. Click on the label where the counter should be placed. 

The new variable is linked to the text object on the label. 

Note: Typically, the counter increases by 1 on each label. For example, 1, 2, 3, 4, 5, etc. 
You can also define different incremental steps. 

Create Date and Time Variable Fields 

Content of the variable field can be filled automatically with the date or time stamp from the 
computer clock or printer clock (for supported printer models). 

1. To display a list of available variable types, click the small arrow next to the 

 button in the Toolbox. 

2. From the list, select New Date Field. A dialog box with date properties opens. 

 
Creating new date variable field 
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3. Leave everything as default, and the date will be used on the label using the format as 
defined in your Windows operating system. 

To place a time stamp on the label, do the following: 

1. To display a list of available variable types, click the small arrow next to the 

 button in the Toolbox. 

2. From the list, select New Time Field.  

3. Click the Finish button. 

4. Click on the label where the counter should be placed. 
The new variable is linked to the text object on the label. 

The date and time fields are updated when you preview or print the label. In this example, the 
values come from the system clock of your computer. 

Use Prefix or Suffix Options 

You can add a prefix and suffix to each variable field on the label. Both are added to the value 
when you preview and print the label. 

1. To display a list of available variable types, click the arrow in the  
button in the Toolbox. 

2. From the list, select New Keyboard Input. A dialog box with variable properties will 
open. 

3. Type the text Enter product weight for the Display this text to the print operator 
option. Set the allowable characters to digits and click the Next button. 

4. Enter kg for the Suffix option. 

 
Defining the variable suffix 

5. Click the Finish button. 

6. Click on the label where you want to position the prompted field. 
The text object is placed on the label and linked to the new variable. When you 
preview or print the label, the suffix kg will be appended to the entered value on the 
right side. 
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Designing an RFID Smart Label 

Overview 

Radio Frequency Identification (RFID) refers to technologies that use radio waves to 
automatically identify individual or groups of items. ZebraDesigner Pro and ZebraDesigner 
printer drivers support programming and printing of RFID tags embedded in a label.  

Note: You can only use RFID functionality in ZebraDesigner Pro if you have installed a 
ZebraDesigner printer driver with the RFID support. 

Create RFID Smart Label 

1. In the Standard toolbar, click the  button. The Label Setup Wizard will start. 

2. Select the printer that supports RFID smart label printing.  

3. Click the Finish button. 
You will see that ‘RF Tag’ command is enabled in the Toolbox on the left side of the 
working window. 

 
RF Tag is available for use 
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Encode RF Tag 

The RF tags that are embedded into the label are usually one of these types:  

• ISO tags, which encode blocks of data 

• UHF tags, which can encode one string of data. 

1. In the Toolbox to begin encoding the data, click the  button.  
The RF Tag dialog box opens. 

 
Encoding contents for RF Tag 

2. From the list box on the top of the dialog box, select the type of the RF Tag you want 
to use. 

3. Select the Use RF Tag in label option.  

Note: If you don’t select this option, the definition of tag content is saved but not sent to 
the printer. 

4. In the section Data Blocks, go to the Data Cell column and click the first available 
block.  

5. Type in the value you want to encode into this block. Repeat the process for other 
blocks. 
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6. Click the OK button.  
A schematic view of the RFID Tag antenna will open in the label background 
identifying the definition of the RFID data on the label. 

 
RFID Tag antenna in the background 

7. You can continue designing the smart label with non-RFID data as described in the 
previous sections. 

Whenever you print the label, the RFID data will be sent to the printer. The printer prints the 
RFID smart label and programs the RFID tag embedded into the label at the same. 

Note: ZebraDesigner Pro can work with Unique RF Tag numbers. Each RFID tag has 
embedded a unique serial number. Some printers can read the Unique RF Tag number 
and it can be used on the label linked with some label objects. 

 



ZebraDesigner Pro User Guide 

30 

 
RF Tag dialog box 

Some thermal printers have the ability to program an RFID tag at the same time as they are 
printing the label. Two different technologies and their encoding methods are joined on the 
same label. Of course, a label must have an embedded RF tag. The tag is paper thin, flexible, 
and small in size, which allows it to be placed inconspicuously under the label. It consists of 
an etched antenna and a tiny chip that can store ID numbers or your custom data in larger 
quantities. This contrasts with a bar code label, which does not store any enhanced 
information, but merely some code number. 

RF tag data encoding options are set in this dialog box. 

Use RF Tag in label: Enable this option if you want to program the tag at the same time as 
the label is printed. If the option is not selected, no RF data is sent to the printer, but the 
definition is remembered for next time. 

Type: Select the type of RF tag you want to use with your printer. You must use 
ZebraDesigner Pro to be able to use RF programming. The list of available tags changes with 
the selected printer. Not all tag types are always available. It also depends on each printer 
model and what kind of RF ID tags can be used with it. There are generally these types of 
tags: 

• ISO tags (TagIt, iCode, ISO): These are block oriented tags. The data can be encoded 
in multiple blocks. 

• UHF tags (ePC): The data is encoded in one block of data. 
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Tag Settings: This section provides the information about the selected tag type. 

Number of blocks: The number of blocks that are available in the RF tag. 

Reserved blocks: The number of blocks that cannot be accessed and used.  

Block size: The size of each block (in bytes). 

Unique RF Tag: If you have the printer and/or the tag type that can provide you with 
the Unique Tag ID, this flag will be set to Yes. Each tag has a unique ID encoded 
already in the production line. If your printer can read this information from the tag, 
you can use it with the label elements. When the Unique Tag ID is supported, you can 
connect it with the label elements using RFID Unique Tag ID contents provider. 
For example: The printer scans Unique Tag ID, remembers it, and prints it on the label 
encoded in a bar code element. 

Antenna offset: To achieve better programming accuracy of the tags this option defines 
the offset for the antenna in the printer. This is the distance from the edge of the label to 
the embedded tag. This option will help you program the tags more accurately. 

Number of retries: The number of times the printer will try to program the tag if the 
first attempt fails. The parameter is sent to the printer with the rest of the data. 

Data Blocks: This section allows you to provide data values for the RF tag. This section has 
different options available for different tag types (UHF or ISO). 

For UHF tags 

Data type: Data type of the selected tag can be specified here. 

Data source: Incoming data that is encoded in the tag can be a fixed value or acquired 
from some variable, defined in the label. 

Data size: The currently used data is previewed here. You can see the amount of space 
still available in the tag. The occupancy of the tag is seen graphically with growing bar 
and numerically with the digit, explaining the number of already used bytes. 

Block locked: If you set the block as locked, the data will be permanently encoded into 
the tag. You will not be able to erase this block to re-program it with some other value. 
Use this option with caution! 

For ISO tags 

The blocks that are dimmed and inaccessible are reserved blocks that cannot be used. 

Block Number: The successive number of blocks in the tag. 

Data source: Select where the data block will receive its value. It can be Fixed, where 
you will manually type in the value or Variable, where the value is acquired from some 
variable defined in the label. 

Data: Type in the tag value manually if the selected data type is Fixed. Select the 
variable defined in the label if the selected data type is Variable. If your variable length 
is greater than the block size, the next block will automatically be reserved for the data. 

Size: The currently used data is previewed here. You can see the amount of space still 
available in the tag. The occupancy of the tag is seen graphically with growing bar and 
numerically with the digit, explaining the number of already used bytes. 

Data type: The data can be encoded as an ASCII string or as a HEX encoded string. 
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Locked: If you set the block as locked, the data will be permanently encoded into the 
tag. You will not be able to erase this block to re-program it with some other value. Use 
this option with caution! 
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Change Printer Settings 

Change Common Printer Settings 

When you start designing a label, tell ZebraDesigner Pro what printer to connect the label to. 
Each label file remembers the printer settings for the selected printer driver on the label. 

This example shows you how to change the printing speed and darkness.  

To change the printer settings, do the following: 

1. From the File menu, select Printer Settings.  
The window with the printer settings opens. 

2. Open the Options tab. 

3. Change the Speed and Darkness options.  

4. Click the OK button. 

5. To save the label, click the  button in the Standard toolbar, or from the menu 
select File > Save. 

 
Printer driver properties 

Note: Any changes in the printer settings dialog box will be saved to the label and 
applied to future print actions. 

You can also change the printer settings right before the label is printed. 

1. From the File menu, select Print. 

2. Go to the Printer tab. 
This tab allows you to change the printer just before printing begins, but it also 
enables you to change common printer settings like speed, darkness, and print 
direction. 

Note: Changes to the settings in the Printer tab will not be saved in the label but used 
only at print time. 
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Change Dithering Options 

Dithering is a process of converting color or gray scale pictures to black and white pictures 
that can be printed on thermal printers. Thermal printers normally cannot print color images 
and can either print a dot on the label or not. There are no intermediate shades of gray. 

During the dithering process all colors and shades of gray in the picture are converted to black 
and white dots, creating the illusion of new colors and shades by varying the pattern of dots. 
Different shades of gray are produced by varying the patterns of black and white dots. There 
are no gray dots at all. In printing, dithering is usually called half toning. Shades of gray are 
called halftones. 

To change the dithering settings, do the following: 

1. From the File menu, select Printer Settings.  
The window with the printer settings will open. 

2. Open the Dithering tab. 

3. Change the Dithering Type option to suit your needs. Look at the preview on the 
right side to see the result of your selection on the label. 

4. Click the OK button. 

5. Save the label by clicking the  button in the Standard toolbar or selecting Save in 
the File menu. 
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Using Toolbars 

Use the Standard Toolbar 

Click on the buttons in the standard toolbar to execute the following actions: 

 
Create new label 

 
Open existing label 

 
Save currently opened label 

 
Cut the selected objects to clipboard 

 
Copy the selected objects to clipboard 

 
Paste the objects from the clipboard 

 
Undo last action 

 
Redo last action 

 
Access to the print functionality. Click on the small arrow in the toolbar 
for more commands 

 
Access to the zoom functionality. Click on the small arrow in the 
toolbar for more commands 

 
Access to the view functionality. Click on the small arrow in the toolbar 
for more commands 

 
Access to the databases. Click on the small arrow in the toolbar for 
more commands 

 
Open the help file 
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Use the Toolbox 

To use the toolbox, do the following: 

1. Click on the icon in the Toolbox to select the object. 

2. Move the mouse over the label. Notice how the cursor has changed. 

3. To place the selected object, click on the label where you want to place the object. 

Some objects have additional shortcuts on the right side of the icon. Using this shortcut, you 
can quickly create a new object with fixed content, create a new variable and connect it to the 
selected object, or connect the object to one already defined variable. 

Use the Text Toolbar 

You can use the text toolbar to quickly format the text objects on the label. 

 
To format text objects, do the following: 

1. Select the text object by clicking it. 

2. Click the appropriate shortcut button in the text toolbar. 

3. To change the font, select the appropriate font from the list in the list box. 

Note: You can limit the display of fonts in the list. You can list all fonts on the system, 
only graphic fonts (TrueType, opentype, type1, bitmap Windows fonts,) or only thermal 
printer resident fonts. Click on the two icons next to the list of fonts. 

4. To change the size of the text, click on the list with font sizes and select the 

appropriate size. You can also click on the   and  buttons that will 
enlarge/reduce the size of the font to the next size. 

Note: You can also change the fonts size directly on the label by resizing the text 
element with a mouse. 

5. To format the text bold, italic, or underline, click on the appropriate formatting 
buttons. 

 
Formats the selected text in bold style 

 
Formats the selected text in italic style 

 
Formats the selected text in underline style 

6. To change the alignment of the text object, click on the appropriate alignment buttons. 

Note: These buttons are accessible only for multi-line text objects. 
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Aligns text to the left edge 

 
Aligns text to the horizontal center 

 
Aligns text to the right edge 

 

Use the Design Toolbar 

The design toolbar is used for: 

• Changing color of the objects. 

• Aligning objects. 

• Rotating objects. 

• Arranging objects. 

Working with Objects 

Define the Text Object 

To place the text object on the label, do the following: 

1. In the Toolbox, click the Text button. 

2. Click the position on the label where you want to place the object. 
The Text Wizard dialog box opens. 

3. Define the contents for the text object. 

4. To advance to the next step of the wizard, click the Next button. 

5. Follow the onscreen instructions in the next steps. 

6. Click the Finish button. 

Note: To edit the object, select it, and then double-click it. The wizard with properties 
appears. 
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Define the Bar Code Object 

To place the bar code object on the label, do the following: 

1. In the Toolbox, click the Bar Code button. 

2. Click the position on the label, where you want to place the object. 
Bar Code Wizard dialog box opens. 

3. Define the contents for the bar code object. 

4. To advance to the next step of the wizard, click on the Next button. 

5. Follow the onscreen instructions in the next steps. 

6. Click the Finish button. 

Note: To edit the object, select it then double-click it. The wizard with properties 
appears. 

Define the Picture Object 

To place the picture object on the label, do the following: 

1. From the Toolbox, click on the Picture object. 

2. Click on the label where you want to place the picture. 
The Open dialog box opens. 

3. Browse for the picture on the hard disk, and then click the Open button. 

Note: To edit the object later, select it, and then double-click it. The wizard or dialog 
box with properties appears. 

Define the Rectangle Object 

To place the rectangle object on the label, do the following: 

1. In the Toolbox, click the Rectangle button. 

2. Click the position on the label where you want the upper-left position of the object to 
be set. 

3. Drag in the bottom-right direction until the object size is correct. 

4. The other method of positioning the rectangle object on the label is selecting the 
Rectangle tool and then clicking the label. A default-sized rectangle will appear, and 
you can resize it using handles around the object. 

Note: If you want to draw a square, grab a handle on one of the rectangle corners, 
simultaneously press and hold the Shift key, then resize the rectangle. A square will be 
drawn. For more useful shortcuts available in the software see Shortcuts. 

5. To move a rectangle to a different position, select it and drag it elsewhere on the label. 

Note: To edit the object, select it then double-click it. The dialog box with properties 
appears. 
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Define the Line Object 

To place the line object on the label, do the following: 

1. In the Toolbox, click on the Line object. 

2. Define the line starting point by clicking the mouse at the start position. 

3. Move the cursor to the end point while holding down the mouse button. 
A line will be drawn from the left to right side of the label. 

Note: To draw a vertical line, click the starting point and then drag the cursor in the up-
down direction. 

Define the Ellipse Object 

To place the ellipse object on the label, do the following: 

1. In the Toolbox, click the Ellipse button. 

2. Click the position on the label where you want the upper-left position of the object to 
be set. 

3. Drag to the bottom-right direction until the object size is correct. 

4. The other method of positioning the object on the label is selecting the Ellipse tool 
and then clicking the label. A default-sized ellipse will appear, and you can resize it 
using handles around the object. 

Note: To draw a circle, grab a handle an on one of the ellipse corners, simultaneously 
press and hold Shift key, then resize the ellipse. A circle will be drawn. For more useful 
shortcuts available in the software see Shortcuts. 

5. To move an ellipse to a different position, select it and drag it elsewhere on the label. 

Define the Inverse Object 

To place the inverse object on the label, do the following: 

1. In the Toolbox, click on the Inverse button. 

2. Click the position on the label where you want the upper-left position of the object to 
be set. 

3. Drag to the bottom-right direction until the object size is correct. 

Note: To draw a square, grab a handle an on one of the rectangle corners, 
simultaneously press and hold the Shift key, then resize the rectangle. A square will be 
drawn. For more useful shortcuts available in the software see Shortcuts. 

4. To move an inverse to a different position, select it and drag it elsewhere on the label. 
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Using Text Wizard 

Text Wizard 

 
First screen of Text Wizard 

The Text Wizard guides you to define all parameters for the text object. 

Fixed text: Select this option if you would like to have a fixed non-changeable content of the 
object. If you select this option, you can enter the text directly in this dialog box. 

Variable text: Select this option if you would like to have variable content in the object. 
Defining the content is defined in the next step. 

Element name: Each text object on the label has a unique name. You can refer to the names 
when you are linking fields together. 

Phantom: If the object is marked as phantom, it is visible on the label during the label design 
but is not printed. 

Font: Currently selected font type is shown in this field. 

• Inverse: Enable this option to use the text in inverse. 

Note: The option is not available for all printers. 

• Select button: You can select different font types for this text object among available 
fonts in the system. 
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Text Wizard - Choosing Variable Text 

 
Text Wizard - Choosing variable text 

Select the type of the variable field you want to use. 

The next page of the wizard depends on your selection here. 
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Text Wizard - Keyboard Input 

Use this variable type when you want the operator to enter a value of the variable from the 
keyboard before printing the specified number of labels. 

 
Dialog box for Text Wizard when Keyboard input option is chosen 

Prompt text for this variable field: Fill in the message that will be shown to the user when 
he enters the values for the variable field. 

Format: Select the format of data you allow to be entered for the variable field. 

Set maximum number of characters: Define the maximum length of characters that can be 
entered for the variable field. 
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Text Wizard - Counter 

On this page of the wizard, you define the counter variable. 

 
Dialog box for Text Wizard when Counter option is chosen 

Starting Value: Set the starting value for the counter. The counter will increment or 
decrement from the starting value. 

Note: You can enter only digits for the starting value. 
  

Prompt for value before print: Click this option to enable entering the starting value of the 
counter when you start printing labels. Enter the text that will be shown before printing. 

The message will be shown on the screen each time the label is to be printed.  

Set maximum number of digits: Define whether the maximum length of digits the counter 
can occupy. 

Increment or decrement: Define that the variable value will increase from label to label, or 
decrease. 

Preview: The field shows the preview of the counter based on your selection. 

Text Wizard - Counter Continuation 

Step: Define the step for your counter. The counter will increase by this number on every 
label. 

Change value every <n> labels: Define the number of label when the counter will change 
value. 
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Rollover when reached: Enter the value, which when reached, will cause the counter to reset 
the value to the starting value. 

Text Wizard - Date Field 

Define the properties of the date field. The variable field will get the value from a computer 
clock. 

 
Dialog box for Text Wizard when Date field option is chosen 

Format: Select the format for your date from the list. You can also enter a custom format. 

Date offset: You can add a certain number of days, months, or years to a current date and 
print that date instead of the current one. 

Preview: The printer will print the date as shown on the Preview field. This allows you to see 
how the selected date format will look on the label. 

Use the printer's internal clock: Enable this option to recall the date information from the 
real time clock (RTC) built in to the printer not the clock from the PC computer. The list of 
available date formats changes accordingly to the capabilities of the selected printer. 
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Text Wizard - Time Field 

Define the properties of the time field. The variable field will get the value from a computer 
clock. 

 
Dialog box for Text Wizard when Time field option is chosen 

Format: Select the format for the time from the list. You can also enter a custom format. 

Preview: The printer will print the time as shown in the Preview field. This way you can see 
how the selected date format will look on the label. 

Use the printer's internal clock: Enable this option to recall the time information from the 
Real Time Clock (RTC) built in to the printer not the clock from the PC computer. The list of 
available time formats changes accordingly to the capabilities of the selected printer. 
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Text Wizard - Database 

Variable field linked to the database gets the value from the specified database field. 

 
Dialog box for Text Wizard when Database option is chosen 

Define: Click this button to open the database wizard that will help you define the link to the 
database. 

Field: Choose one of the available database fields as a source for the variable field. 

Length: Define the maximum length of the string in the variable. If a field in the database 
contains more characters, they will not be printed. This option is useful if the field length in 
your database is not fixed (for example tab delimited ASCII file) or if you don't want to 
reserve space for all the characters in database's field. 
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Text Wizard - Linked Field 

Select this type of field to merge the contents of selected variable fields into one field. The 
selected input variable fields are combined values and used as the value for the current object. 

 
Dialog box for Text Wizard when Linked Fields option is chosen 

Available elements: The combo box contains the list of all defined variable fields on the 
label. You can select the fields and click the Add button to add them to the resulting value. 

Selected elements: The list box contains the names of the selected variable fields, whose 
values will be merged into the resulting value. Click the up and down arrow buttons to change 
the relative position of the selected variable fields within the merged value. 

Separator: Select the optional separator character that will be included between the merged 
variable fields. 

Note: When you are merging the variable field containing time or date value from the 
printer Real Time Clock, make sure the fields positioned before and after the Real Time 
Clock field do not exceed 31 characters. 
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Text Wizard - RF Tag Unique ID 

Printers with RFID functionality can program RF tags embedded in the labels. Each RF tag 
has a unique ID number that was programmed into the tag during the manufacturing process. 
The Unique number cannot be altered, but the RFID-enabled printer can read it. 

RF Tag Unique ID functionality allows you to read the unique ID number from the RF tag 
and use the content with the selected bar code object. When the label is printed, the printer 
will first read the unique ID from the tag and then immediately use the value with the bar 
code object. 

RF Tag Unique ID can only be used with the bar code objects that are printed as internal 
printer objects. You must format the bar code object to use internal fonts not TrueType fonts. 

 
Dialog box for Text Wizard when RF Tag Unique IF option is chosen 

Selected RF Tag: Select the tag from the list. 

Note: Only tags supported by the currently supported printer are listed. 

Read Source: Select the source of the RFID data. 

Data Format: Select the format of the data. 

Preview (WYSIWYG only): Because RF Tag Unique ID information is not returned to the 
labeling software, you do not see the actual data. Enter the data in a format similar to the 
format encoded in the RF tag. This information will be used for preview on the label only.  
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Text Wizard - Visual Basic Expression 

Select this type of field to manipulate your variable fields with the Visual Basic function. The 
result of the expression will be used with the current object on the label. You can define one-
line expressions that must follow Visual Basic programming syntax. 

Look at the samples in the dialog box for ideas of what can be done with the Visual Basic 
script. 

 
Dialog box for Text Wizard when Visual Basic expression option is chosen 

Expression: Enter the Visual Basic expression. Include the names of the variable fields in the 
square quotes. 

Build Expression: Click this button to open the Expression Builder text editor with reference 
to frequently used Visual Basic functions. 

VB Script Help: Click this button to open the Microsoft help files explaining syntax and 
usage of Visual Basic scripting. 

For example: The Visual Basic expression functionality can be used for merging text 
fields or to perform simple mathematical operations. 
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Text Wizard - Prefix and Suffix 

The variable element can have prefix and suffix values. The prefix text is placed in front of 
the variables value. The suffix text is placed at the end of the variables value. 

 
Setting Prefix and Suffix string for the variable text element 

Note: If you leave the edit fields empty, the prefix/suffix will not be used. 

Prefix and suffix can be used in situations where they are required only if the variable has a 
value set. If the variable is empty, the prefix/suffix will not be printed. 

Note: When you use the printer Real Time Clock for date or time fields, the length of 
prefix and suffix cannot exceed 31 characters. 
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Using Bar Code Wizard 

Bar Code Wizard 

 
First page of bar code Wizard 

The Bar Code Wizard guides you to define all parameters for the text object. 

Fixed bar code data: If you would like to have fixed non-changeable content for the text 
object, select this option. If you select this option, you can enter the text directly in this dialog 
box. 

Variable text: If you would like to have variable content for the text object, select this option. 
Defining the content is defined in the next step. 

Note: When entering values for RSS composite bar codes, you need to provide the 
value for the linear and composite (2D) parts at the same time. 

Use the following syntax for entering values for RSS composite bar codes. The pipe character 
(|) is used to distinguish between the components. 

Syntax: <linear part>|<composite part> 
Example: 12345|description 

Element name: Each bar code object on the label has a unique name. You can refer to the 
names when you are linking fields together. 

Phantom: If the object is marked as phantom, it is visible on the label during the label design, 
but is not printed. 

Bar Code Type: Click on the Define button to select the bar code type you want to use on the 
label. 



ZebraDesigner Pro User Guide 

52 

Bar Code Wizard - Choosing Variable Bar Code 

Select the type of variable field you want to use. 

The next page of the wizard depends on your selection. 

Bar Code Wizard - Keyboard Input 

Use this variable type when you want the operator to enter a value for the variable from the 
keyboard before printing the specified numbers of labels. 

Prompt text for this variable field: Fill in the message that will be shown to the user when 
he will enter the value for the variable field. 

Format: Select the format of data you allow to be entered for the variable field. 

Set maximum number of characters: Define the maximum length of characters that can be 
entered for the variable field. 

Bar Code Wizard - Counter 

On this page of the wizard, you define the counter variable. 

Starting Value: Set the starting value for the counter. The counter will increment or 
decrement from the starting value. 

Note: You can enter only digits for the starting value. 
  

Prompt for value before print: Click this option to enable entering the starting value of the 
counter when you start printing labels. Enter the text that will be shown to the user before 
printing. 

The message will be shown on the screen each time the label is to be printed.  

Set maximum number of digits: Define the maximum length of digits the counter can 
occupy. 

Increment or decrement: Define whether the variable value will increase from label to label 
or decrease. 

Preview: The field shows the preview of the counter based on your selection. 

Text Wizard - Counter Continuation 

Step: Define the step for your counter. The counter will increase by this number on every 
label. 

Change value every <n> labels: Define the number of labels, when the counter will change 
the value. 

Rollover when reached: Enter the value, when reached, will cause the counter to reset the 
value to the starting value. 
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Bar Code Wizard - Date Field 

Define the properties of the date field. The variable field will get the value from a computer 
clock. 

Format: Select the format for your date from the list. You can also enter a custom format. 

Date offset: You can add a certain numbers of days, months, or years to a current date and 
print that date instead of the current one. 

Preview: The printer will print the date as shown in the Preview field. You can see how the 
selected date format will look on the label. 

Bar Code Wizard - Time Field 

Define the properties of the time field. The variable field will get its value from the computer 
clock. 

Format: Select the format for the time from the list. You can also enter a custom format. 

Preview: The printer will print the time as shown in the Preview field. You can see how the 
selected date format will look on the label. 

Bar Code Wizard - Database 

Variable field linked to the database gets the value from the specified database field. 

Define: Click this button to open the database wizard that will help you define the link to the 
database. 

Field: Choose one of the available database fields as a source for the variable field. 

Length: Define the maximum length of the string in the variable. If the field in the database 
contains more characters, they will not be printed. This option is useful if the field length in 
your database is not fixed (for example tab delimited ASCII file), or if you don't want to 
reserve space for all the characters in database's field. 

Bar Code Wizard - Linked Field 

Select this type of field to merge the contents of the selected variable fields into one field. The 
selected input variable fields are combined values and used as the value for the current object. 

Available elements: The combo box contains the list of all defined variable fields on the 
label. You can select the fields and click the Add button to add them to the resulting value. 

Selected elements: The list box contains the names of the selected variable fields, which will 
be merged into the resulting value. Click the up and down arrow buttons to change the 
relative position of the selected variable field within the merged value. 

Separator: Select the optional separator character that will be included between the merged 
variable fields. 
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Bar Code Wizard - RF Tag Unique ID 

Printers with RFID functionality can program RF tags embedded in the labels. Each RF tag 
has a unique ID number that was programmed into the tag during the manufacturing process. 
The Unique number cannot be altered, but the RFID-enabled printer can read it. 

RF Tag Unique ID functionality allows you to read the unique ID number from the RF tag 
and use the content with the selected bar code object. When the label is printed, the printer 
will first read the unique ID from the tag and then immediately use the value with the bar 
code object. 

RF Tag Unique ID can only be used with the bar code objects that are printed as internal 
printer objects. You must format the bar code object to use internal fonts not TrueType fonts. 

Selected RF Tag: Select the tag from the list. 

Note: Only tags supported by the currently supported printer are listed. 

Read Source: Select the source of the RFID data. 

Data Format: Select the format of the data. 

Preview (WYSIWYG only): Because the RF Tag Unique ID information is not returned to 
the labeling software, you do not see the actual data. Enter the data in a format similar to the 
format of the RF tag. This information will be used for preview on the label only. 

Bar Code Wizard - Visual Basic Expression 

Select this type of field to manipulate your variable fields with the Visual Basic functions. 
The result of the expression will be used with the current object on the label. You can define 
one-line expression that must follow Visual Basic programming syntax. 

Look at the samples in the dialog box for ideas of what can be done with the Visual Basic 
script. 

Expression: Enter the Visual Basic expression. Include the names of the variable fields in the 
square quotes. 

Build Expression: Click on this button to open the Expression Builder text editor with 
reference to frequently used Visual Basic functions. 

VB Script Help: Click on this button to open the Microsoft help files explaining syntax and 
use of Visual Basic scripting. 

For example: The Visual Basic expression functionality can be used for merging text 
fields or to perform simple mathematical operations. 

Bar Code Wizard - Prefix and Suffix 

The variable element can have prefix and suffix values. The prefix text is placed in front of 
the variable's value. The suffix text is placed at the end of the variable's value. 

Note: If you leave the edit fields empty, the prefix/suffix will not be used. 

Prefix and suffix can be used in situations where they are required only if the variable has a 
set value. If the variable is empty, the prefix/suffix will not be printed as well. 
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Using EAN.UCC 128 Wizard 

This wizard allows you to define the data structure for EAN.UCC 128 bar code. This kind of 
bar code has different areas of application that include trade items, logistic units, assets, and 
locations. 

The EAN.UCC 128 bar code is an extremely flexible symbology. It allows representation of 
data of variable length, and makes it possible to encode several pieces of information in one 
bar code symbol. This is called concatenation. An Application Identifier is a field of two or 
more characters at the beginning of a data value. Application identifiers are prefixes that 
uniquely identify the meaning and the format of the data field following. The data fields are 
either of fixed or variable length, depending on the AI. 

Step 1: Choose the application identifier 

 
EAN.UCC 128 Wizard: Choosing application identifier 

The dialog in the first step of the Wizard allows you to select the EAN.UCC 128 bar code 
data structure. Each bar code is composed of one or more Application Identifiers and the 
corresponding data. 

Choose one of the Application Identifiers in this list. You can add, edit, or delete Application 
Identifiers from the bar code later in the process. 
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EAN.UCC 128 Wizard: How check digit should be applied 

If you have selected an Application Identifier with data that includes a check digit (for 
example, AI (01) - GTIN, Global Trade Item Number), then first you have to select how the 
check digit will be applied. The possible options are: 

 Automatic calculation: Check digit will be calculated by the application. 

 Check digit to be entered with data: Manually enter the data and check digit. The 
application will verify if the entered check digit is valid. 
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Step 2: Application Identifier Input Type 

 
EAN.UCC 128 Wizard: Where the data for AI is obtained from 

When the Application Identifier is selected, you will have to define where the data for its 
value was obtained. These are the possible options: 

• Fixed: The application identifier will have a fixed value on every label. 

• New variable: The application identifier will be linked to the variable and have 
variable value on each label. You will define a new variable. 

• Use existing variable: The application identifier will be linked to the variable and 
have a variable value on each label. You will define a new variable. 
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Step 3: Enter the value for the Application Identifier 

Entering fixed value for the application identifier 

 
Entering fixed value for the application identifier 

If you selected a fixed value in the previous dialog box, you should enter a value for the 
Application Identifier here. The Wizard will let you know about the required data format for 
this AI and how long the AI value should be. For some AIs the field length is fixed to certain 
number of digits; for others, only the maximum number of possible digits is stated. You will 
also be reminded of the AI's proper field format (numeric, alphanumeric) if you enter 
incorrect data. 
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Entering a variable value for the application identifier 

 
Creating new variable for the application identifier 

If you selected new variable values in the previous dialog box, a new variable field will be 
created. You will have to provide some information about the variable being used. 

Calculate the Check Digit 

To select how the check digit will be calculated, do the following: 

1. Enter the check digit with the data and the software will validate it. 

2. The software can calculate the check digit. 

Define a New Variable 

Define the properties of the variable that will provide a value for the application identifier. 

Prompt: Enter the text that will be displayed to the user at print time. 

Format: Define the format of the variable. 

Counter: If the variable will be a counter, define its properties. 
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Step 4: List of selected application identifiers 

 
Listing the selected application identifiers 

This is the last step of the EAN.UCC 128 Wizard. Here you can add, edit, or delete 
Application Identifiers and define a separator. 

Application Identifiers selected: In this field all selected application identifiers for the bar 
code are listed in the order of creation. You can change the order with the arrow buttons. 

Add, Edit, or Delete buttons: Use these buttons to add additional application identifiers and 
edit or delete existing ones. 

Input Application identifier delimiter: Define left and right separators among different 
application identifiers. The default setting is to use parenthesis. 

Preview: A sample bar code content based on your application identifier selection is shown 
here. 

To exit the wizard, click the Finish button. 

Selecting Bar Code Type 

Settings for Advanced Bar Codes 

EAN.UCC 128 Bar Code 

This bar code is combined from one or more input values and standard AID - Application 
Identifiers. Each AID must be followed by the standard values. These values can be fixed or 
variable. 
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When you select the EAN.UCC 128 bar code, the Bar code data field in the Bar code Wizard 
dialog box is disabled. To define the contents of the bar code, click the Next button.  

From the list of available Application Identifiers select the first identifiers. It will be written in 
brackets below the bar code. 

When the Application Identifier also includes check digits, you have to define whether it will 
be calculated or entered together with data. 

Next, define how you will set the values for the selected identifier. You may enter a fixed 
value or define a variable value.  

Fixed values 

When values are fixed, the Wizard dialog box will inform you what to enter.  

The defined AID is presented on the list of selected Application Identifiers. Click the Add 
button to add a new AID or the Delete button to delete an existing one. 

Should you need to change the AID and the data, select the AID and click the Edit button. 

You can sort the listing of AID by using the Up and Down buttons.  

All the settings can be previewed on the Preview field.  

The separator among Application Identifiers can be defined by entering the required separator 
for the left and for the right side of the Application Identifier. The default separator is 
brackets. 

Variable values 

EAN.UCC 128 bar code supports keyboard variables – the variable data will be entered from 
the keyboard. 

You can define the Prompt – the message for the operator, who will enter the data. 

The data can be numeric only or all characters. 

The value can be fixed or incremented/decremented on every label or a certain number of 
labels with the desired step. 

The variable data will be written in the Preview field as a series of A characters. 

When you are satisfied with the settings, click the Finish button to put the EAN.UCC 128 bar 
code on the label.  

PDF 417 2D Code 

General tab 

Y expansion factor 
This option defines the height of the bar code symbol. 

Security tab 

According to the standard, you can select among 9 levels of security. Higher security levels 
allow more reliable reading regardless of errors, but the bar code symbol is bigger. 

Truncated bar codes can be used where label damage is unlikely and there is no demand for a 
high level of security. The truncated symbol is smaller. 
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Aspect Ratio 
It is the ratio between the number of columns and the number of rows.  

Contents 

PDF 417 code can encode: 

• Full 128 ASCII character set 

• All 128 Extended ASCII characters 

• 8-bit binary data 

 

DataMatrix Bar Code 

General tab 

Y expansion factor 
This option defines the height of the bar code symbol. 

Aspect Ratio 
It is the ratio between the number of columns and the number of rows. Enter the value in the 
fields. 

Details tab 

ECC Type 
Error Correction Codes define the security level. You can select one from the standard levels 
in the pull-down menu. 

Format ID 
This option defines which character set will be used in the bar code. You can select one of the 
formats with the following filter. 

01 and 11 0..9, space 

02 and 12 A..Z, space 

03 and 13 A..Z, 0..9, space 

04 and 14 A..Z, 0..9, space,.-/ 

05 and 15 7-bit ASCII lower part (from 0 to 127) 

06 and 16 all 

07 and 17 7-bit ASCII 

 

The formats from 1 to 7 allow a data length up to 500 characters, while formats from 11 to 17 
allow up to 2000 characters. 
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Border Size 
Factors from 1 to 15 set the dimension of the border in the shape of the character “L”. 

Data Matrix can encode: 

• Full 128 ASCII character set 

• All ISO characters 

• All EBCDIC characters 

MaxiCode 2D Code 

General tab 

Y expansion factor 
This option defines the height of the bar code symbol. 

Details tab 

When the option Structured is not selected, the content of the bar code is optional.  

For Structured bar code you may encode only standard contents. 

Edit Bar Code Dialog Box 

This dialog box is displayed when you click the Define button on the bar code dialog box. On 
this dialog box you specify the type of bar code you want to use on the label and all additional 
advanced settings: how the bar code should be generated, if the check digit should be 
automatically calculated or not, and various other options. If the Enable preview check box is 
checked, a preview of a resulting bar code is displayed on the right side of the dialog box. 

When you are satisfied with the bar codes properties, confirm the changes you made by 
clicking the OK button or reject them and keep previous settings by clicking the Cancel 
button. 

The Edit bar code dialog box has several pages (tabs). 
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General Tab 

On this tab, you can select the bar code type you want to use and the properties of the bar 
code. 

 
Edit bar code dialog box – General tab 

Type of bar code: The required bar code symbology is selected from the tree list of available 
bar codes. 

Symbol height: The height dimension of a bar code can be specified either by entering a 
value here or by resizing the bar code symbol directly on the label. 

X-Expansion factor: The expansion factor defines the width of the bar code symbol. 

Ratio: This is the ratio between narrowest and widest bar in the bar code. It is locked for the 
majority of bar codes, but it can be changed for some. 

Base object width: Shows the width of the narrowest bar in the bar code. 

Print bar code as graphics: Select if bar code should be converted to a picture and sent to 
the printer as image or should the printer print bar code as an internal element. Printing 
internal bar codes will speed up label printing because less data must be transferred to the 
printer. 

Note: If the printer does not support the selected bar code internally, the option Print 
bar code as graphics will not be available. All office printers will print bar codes as 
pictures. 
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Check Digit Tab 

This tab is used to specify if you want to use the check digit in the bar code or not. This 
option can only be modified for the bar codes that allow you to enable and disable the check 
digit. 

Some bar code standards include the check-digit by definition and it cannot be omitted. An 
example of such bar codes are EAN and UPC bar codes, where the check digit cannot be 
disabled at all. But some codes allow you to freely enable/disable the check-digit. 

Note: We recommend that you always include the check digit character in the bar code. 
It will increase the scanning reliability. 

 
Edit bar code dialog box – Check digit tab 

You can choose whether you want to input the check digit value, or let the program calculate 
it for you: 

Auto-generate check digit: Check digit is calculated by the software. You enter the bar code 
data only. For example: when using EAN-13 bar code, you enter the first 12 digits; check 
digit on the 13th place will be calculated and added automatically. 

Verify the provided check digit: Use this command when you want to enter the value for the 
check-digit. At print time, the entered check digit will be verified for validity. 

Enable custom check digit algorithm: You can set a custom algorithm for calculating the 
check digit. Click on the button Select to choose the algorithm. 
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Human Readable Tab 

On this tab, you can set the options regarding position and format of the bar code 
interpretation. 

No interpretation: Bar code object does not have any human interpretation. 

Below bar code: All data encoded in the bar code is placed beneath the bar code symbol as 
human readable characters. 

Above bar code: All data encoded in the bar code is placed above the bar code symbol as 
human readable characters. 

Font: Using the Font button, you can choose the font for auto-translation text. The option 
Auto font scaling will adjust the font of the auto translation text to the size of the bar code. 

Note: You can format the font for human interpretation only if the bar code is printed as 
a graphic. When printing the bar code as an internal printer object, the printer will print 
the interpretation using resident built-in fonts. 

Contents mask sets the custom format of the human interpretation. 

 
Edit bar code dialog box – Human readable tab 
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Details Tab 

On this tab, you can define advanced settings for the bar code. 

Note: Not all of these options are available for all bar codes and printers. 

Include quiet zones: Check this field if you want the bar code to have some white space in 
the front and in the end for increased readability. 

Descender bars: Some bars of a bar code will be longer than others. This is typically used 
with EAN and UPC bar codes that have longer bars in the beginning, in the middle and in the 
end of the bar code. 

Mirror horizontally/mirror vertically: The bar code can be mirrored vertically and 
horizontally. The bar code will usually have to be printed as a graphic for this option to be 
accessible. 

Intercharacter gap: Some bar codes allow you to change the gap between characters in the 
bar code (e. g. Code-39). 

Include EAN white space: Before and after the bar code a special character is inserted,  or. It 
indicates the width of the bar code. If you put any other object in the area of the bar code, it 
will reduce the readability of the bar code. This option is valid only for EAN bar codes. 

 
Edit bar code – Details tab 
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Supported Bar Code Types 

Bar code 
Group 

Bar code Types 

EAN and 
UPC 

EAN-8, EAN-8 + 2-digit supplement, EAN-8 + 5-digit supplement, 
EAN-13, EAN-13 + 2-digit supplement, EAN-13 + 5-digit 
supplement, EAN-14, DUN-14, UPC Case Code, UPC-A, UPC-A + 
2-digit supplement, UPC-A + 5-digit supplement, UPC-E, UPC-E + 
2-digit supplement, UPC-E + 5-digit supplement, UPC-E(1), 
EAN.UCC 128, SSCC, Bookland, Addon 2, Addon 5 

Linear Interleaved 2 of 5, ITF 14, ITF 16, Code 39, Code 39 Tri Optic, 
Code 39 Full ASCII, Code 32, Code 93, CODE 128 (A, B and C 
subsets), MSI, Codabar, Postnet-32, Postnet-37, Postnet-52, 
Postnest-62, Kix, Pharmacode, Plessey, Anker 

RSS Linear RSS symbologies 
RSS14, RSS14 Truncated, RSS14 
Stacked, RSS14 Stacked Omni directional, RSS Limited, RSS 
Expanded 
Composite RSS symbologies 
RSS14, RSS14 Truncated, RSS14 Stacked, RSS14 Stacked Omni 
directional, RSS Limited, RSS Expanded, UPC-A, UPC-E, EAN-8, 
EAN-13, EAN.UCC 128 & CC-A/B, EAN.UCC 128 & CC-C 

Two-
dimensional 

2D-Pharmacode, PDF-417, DataMatrix, MaxiCode, Aztec, QR, 
MicroQR, Codablock F, MicroPDF, InfoGlyph 

 

Select Objects 

To select the object on the label, do the following: 

1. In the Toolbox, click the  button. 

2. Click on the object on the label that you want to select. 

To select two or more objects, press the Shift key, and hold down, while clicking the object 
with a mouse. 

The objects can be selected, cut, copied, pasted, and edited with the right mouse button. If you 
click the right mouse button on the object, the menu shows all the available commands. Note 
that these commands are equivalent to correspondent menu commands. 

You can also change the anchoring point of a selected object by holding Ctrl while clicking 
the placeholders (corners of the bounding box) of the object. 
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Edit Objects 

To edit the properties of the object, do the following: 

1. Double-click the object on the label. 
The dialog box with object properties opens. 

Note: You can also press the Enter key while the object is selected. 

2. Make modifications to the object properties. 

3. Click the Finish button. 

Move Objects 

To move the object on the label, do the following: 

1. Select the object. 

2. Click on the object with the left mouse button. 

3. Hold the mouse key down. 

4. Move the position of the cursor on the screen. 
The object will move with the cursor. 
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Aligning Objects 

First you have to select objects that you want to align. 

Note: All objects are aligned relative to the first selected object. 

Then click appropriate buttons in the Design toolbar to align selected objects to each other. If 
Align toolbar is not visible (by default it is located on the very right side of the window), 
enable the Design toolbar in the Toolbar option in the View menu. 

You can align objects to: 

 Left 

 Right 

 Horizontal center 

 Top 

 Bottom 

 Vertical center 

 

You can also distribute object evenly, so that spacing between them is equal: 

 Horizontally 

 Vertically 

Note: If you hold the CTRL key while clicking the buttons, objects are aligned relative 
to the label and not to the first selected object. 

Resize Objects 

To resize the object on the label, do the following: 

1. Select the object. 
The selected object is framed with a rectangle. 

2. Click on one of the small rectangles in the corners of the rectangle. 

3. Hold the mouse key down. 

4. Move the position of the cursor on the screen. 
The object will resize with the cursor. 
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Rotate Objects 

To rotate the object, do the following: 

1. Select the object. 

2. In the Design Toolbar, click the  button. 
The object will be rotated 90° clockwise. 

Note: If the Design toolbar is not visible in the application, enable the toolbar in the 
Toolbars section in the View menu. 

Supported Graphics Formats 

The following graphical formats are supported: 

File extension Graphics type 

BMP, DIB, RLE Windows Bitmap 

GIF CompuServer Bitmap 

JPG, JPEG, JPE JPEG Bitmap 

TIFF, TIF, FAX, 
G3N, G3F 

TIFF Bitmap 

PNG Portable Network Graphics 

WMF Windows Metafile 

EMF Enhanced Windows Metafile 

ICO Windows Icon 

CUR Windows Cursor 

TGA, TARGA, 
VDA, ICB, VST, 
PIX 

Targa Bitmap 

PXM, PPM, PGM, 
PBM 

Portable Pixmap, GreyMap, 
BitMap 

JP2 JPEG2000 

J2K, JPC JPEG2000 Code Stream 

PCX Paintbrush 
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Working with Variable Data 

Dynamic Data Overview 

You may want to print labels on which the data changes for each label, for example, counter, 
serial numbers, date, and time. To accommodate the changing data, ZebraDesigner Pro can be 
used to format labels using the variable fields. Variable field can be used with text and 
graphic objects. 

There are several types of variables you can choose. Data, which must be printed as a 
variable, is prepared at the time of printing. It can be entered in the program in these ways: 

• by the operator from the keyboard 

• from the computer’s clock (date and time) 

• from the label design (using counters with predefined starting values and steps) 

• from the RF tag embedded into the label (RF Tag Unique ID) 

• as output of 'Linked field' or 'Visual Basic expression' 

• database can be used to provide data for the fields 

The variable data can be the same for many labels and/or specific for one label only.  

Working with Databases 

ZebraDesigner Pro allows you to use databases in which your data is stored. Database types 
can be: 

• ASCII (text file) where fields are fixed-length or are separated with any selected 
character 

• Microsoft Excel database 

• Microsoft Access database 

• Existing ODBC Data Sources 

You can use a single database on the same label. 

Databases are very useful when printing labels with a large quantity of different data and 
variable values. You don't have to enter values for every variable before label production any 
more; you can use previously prepared database instead. A database in the ASCII text file can 
be created in any text editor (for example Notepad); it can be also exported from other 
applications (for example Microsoft Word). You can also use Microsoft Excel to edit your 
data. 

Before you can use the data from the database, you have to link the database on the label. 
During this process, the database fields get connected to the variable fields on the label. 

When you start printing labels, every variable field will automatically get the value from the 
linked database field. Each record in the database is used on a single label. 
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Using Data from the Databases 

Imagine that you have the following database that contains first and last names of people: 

field1 field2 

John Smith 

Jane Wright 

Bob Doe 

1. To use the data on the label, you must first define this database using the Database 
Wizard. 

2. To include two variable texts on a label, create two text objects. 

3. In the text wizard, select Variable contents and click the Next button. 

4. Select the Database option as the source of variable data. 

5. Link both text objects to the variable fields, each to a separate field. 

When you print the labels, each of the text objects on the label will get the value from the 
corresponding field in the database. When one label is printed, the next record is used for the 
second label and the process is repeated. Each name and surname is printed on a separate 
label. 
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Work with Visual Basic Expressions 

Visual Basic expressions allows you to manipulate the data values on the label. Input to 
Visual Basic can be fixed values or variable fields from the label. The output is always a data 
value that is used as content for the current object. 

The expression is a one-line Visual Basic script. You can use up to 100 characters for your 
expression. 

Note: The multi-line commands like "if..then..else.." cannot be used with the Visual 
Basic expression. You can use one-line expressions. 

A Visual Basic expression must follow the Visual Basic script programming syntax. For more 
information on how to write your expressions, refer to the Microsoft help on Visual Basic 
scripting. Click on the button 'VB Script Help' in VB script step in the Text or Bar Code 
wizard to open the Microsoft help. 

Note: You can also open the Visual Basic reference help file VBS55.CHM in the Bin 
folder of ZebraDesigner Pro folder. 

Some common samples of Visual Basic expressions: 

Visual Basic Expression The result Comment 

1 + 4 * 20 81 Numeric 
calculation 

"#" + LEFT("1234567890",5) #12345 Working with 
string functions 

[MyField1] + "-" + [MyField2] The values from 
variable fields 
MyField1 and 
MyField2 are merged 
together. 

Concatenating 
string values 
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Using Expression Editor 

The labeling software has a simple text built-in editor. You can use it to design your own 
simple Visual Basic scripts. 

The Expression editor is a programming text editor with constant access to command 
reference of the script language you are currently using. 

The Expression editor lets you edit your scripts and expressions with ease. The Load and 
Save buttons allow you to import / export Visual Basic scripts from / to external text files. 
The editor uses standard shortcuts for positioning of the cursor and working with text files. 
Standard Search and Replace shortcuts (Ctrl + F, Ctrl + R) are also available. 

The working window is divided into four parts. 

Category This section contains the groups of available commands, functions, 
and operators. Similar objects have been grouped together for 
easier identification and faster search. 
The groups are displayed as a tree-view. Select the main group 
name to display all its contents into the Name section. Or you can 
click the plus sign in front of the group name (if available) to 
display all defined sub-groups. Then select the sub-group name to 
display only its contents. 

Name This section will display the contents of the selected group in the 
Category section. All available commands, functions, operators 
etc. will be listed here. If you select one of them, its properties will 
be displayed in the Description section. If you want to insert the 
selected operands into the Expression field, double click its name 
or click the Insert button. 

Expression This section is the main workplace of the Expression editor. Use it 
to write and modify the script you are working on. 

Description This section displays the name, sample use and description of the 
currently selected operand in the Name section. 
You will get an idea of how the current operand should be used. 

Language Help: The button will open the help file with the detailed reference of the Visual 
Basic script. 



ZebraDesigner Pro User Guide 

76 

Database Wizard 

Use Database Wizard 

The process of defining a new Database access function consists of four steps (pages). On 
those pages you enter the data required by the Wizard. You can go to the next step (page) by 
clicking the Next button or return to previous with the Previous button.  

When all necessary data has been entered, the Finish button will become available, allowing 
you to complete the process of defining a new Database access function. Note that some 
options have predefined values, so you don't really need to go through all the steps of a 
wizard. 

Select the Database File 

 
Database wizard – Selecting database file 

Enter the full path name of the database file in the edit box or use the Browse button to find 
the file on your computer. 

Note: You can only browse to the databases that are stored in the files. If you use 
databases through ODBC or OLE DB drivers, you will have to set up the connection 
parameters in the ODBC Data Sources administration in the Control Panel. 
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Select the Desired Fields 

 
Database wizard – Selecting fields 

On this page, you can select the fields you want to use on the label. All fields in a table are 
selected by default, but you will probably want to deselect some of them, especially if you 
have a large table. Variables will be created for each selected field and can later be attached to 
objects. 
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Select the Records to Print 

 
Database wizard – Selecting which records will be printed 

Select the desired option for how you want to use the records in the database. By default, the 
option I want to print all records from the table is set and all records in a table will be 
printed one at a time. Each record will be printed only once. 

If you do not want to print the entire database, you can select which records should be printed. 
In this case, select the option I want to select which record to print. Before printing you 
will be shown a dialog box with all records from the database. Then you will be able to select 
which records should print. 

By default, records are used once for a single label. If you would like to print several copies 
of a label with database data, you can define it in the second part of this step of the Wizard. 

A field in table contains quantity to print option will let you chose some field in the 
database. This field has the information about the quantity of labels for each record. For 
example, you have a database with records of your products. It contains a field with a numeric 
value where the required number of label copies is stored. Select this field and let the 
application print the quantity of labels specified here. 

I will enter print quantity for each record: This option is accessible only if you have 
defined that you want to select which records should be printed. Before printing you will be 
able to select which records will be printed in the selection dialog box. At the same time, you 
will be able to type in the exact label copy for each selected record.  
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Select Variable Quantity from the Database Field 

Select a field in the database that contains the label quantity information. The database record 
will be printed on as many consecutive labels as the selected field contains. 

Note: Make sure to select the field that has been formatted with the numeric data. 

Add Fields to the Label 

 
Database wizard – Adding fields to the label 

On this page, you specify if you want the wizard to generate text objects on the label that are 
already linked to corresponding fields in the table. Text objects are created in the upper left 
corner of a label, but you can move them to another position. 
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Link Label to Text Databases 

Overview 

Text databases are text files containing data values that can be used for variable objects on the 
label. The text database is not a real database. It contains the data values but lacks the 
information of the data structure, name of the fields, and maximum lengths of the fields. You 
have to provide the missing information before ZebraDesigner Pro can use the data from such 
a text database. 

Connect to a Database 

ZebraDesigner Pro offers a Database Wizard that guides you through the necessary steps to 
connect the database to a label.  

To connect your label to a database using the Database Wizard, do the following: 

1. In the Standard Toolbar, click the  button. 

2. Click the Browse button and point to the text database SAMPLE.TXT in the 
Samples folder. 

 
Selecting the text database 

3. Click the Next button. 

Note: If you connect to the database for the first time, you need to define the database 
structure. Continue with the next section. 
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Format the Data with the Text File Wizard 

Because text files do not contain structural information like real databases do, you must 
define the fields and their data structure. When you use the same text database again, you 
won't have to define the structure again. 

1. Choose the data type for the selected text database. The fields are delimited by comma 
so you must select the Delimited option.  

 
Defining the type of the text database 

2. Click the Next button. 

3. Review if ZebraDesigner Pro has properly auto-determined the format of the text file. 
The delimiter must be set to Comma. 

 
Defining the fields in the text database 
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4. Click the Next button. 

5. Accept the default field names and click the Next button. 

6. Review the text database structure. The field names and their maximum lengths are 
displayed.  

7. To close the Text File Wizard, click the Finish button. 

The link to the database has been created, and database fields are available on the label.  

ZebraDesigner Pro brings you back to the Database Wizard. 

Place Database Fields on a Label 

The next step in the Database Wizard opens the dialog box with the list of available fields 
from the database.  

1. By default, all fields from the database will be used on the label. Click the Next 
button. 

 
Using all fields in the text database 

2. Specify what records and how many you want to print: 
Select the options I want to select which record to print and I will enter label 
quantity for each selected record. Before printing labels, the table with the records 
will open, and you will be able to select the records you want to print and the quantity 
of labels for each record. 

 
Specifying which records from the database will be printed and in what quantity 

3. Click the Next button. 
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4. Select if the Database Wizard should link all selected fields from the database to the 
text objects on the label or if you want to link the fields manually to the label.  

5. Click the Next button.  

6. Select I want a text object for each selected field and click the Finish button. 

 
Each field from the database will be linked to a text object 

The label will show several text objects. Every field from the database is linked with the text 
object on the label. 

Use Print Preview to Select Data and View a Label 

Now you will simulate label printing using print preview. 

1. In the Standard Toolbar, click on the   button. 

2. The Print dialog box opens with the Quantity of labels set to Variable quantity 
(entered for each database record). This setting corresponds to your selection in the 
Database Wizard when you have selected the options I want to select which record 
to print and I will enter label quantity for each selected record. 
 
Only the records you select will be printed in the defined quantity. 

 
Print / Print preview dialog box 

3. To choose which records to print from the database, click on the Select Records 
button. The Record Selection dialog box will open. 

4. Select the records from the database you want to print and enter the number of labels 
you want to print for each selected record. 
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Record selection dialog box 

5. Click the OK button. You will return to the Print dialog box. 

6. Click the Preview button. Now you can preview the labels on the screen. Note that the 
text objects on the label change for each new record. 

 
Preview of the second label in the series 

7. In the Command window to advance to the next label in the series, click the Next 
button. After you see the last label in the preview series, ZebraDesigner Pro re-opens 
the Print dialog box. 

8. To close the Print dialog box, click the Close button. 

Print a Label 

When you are certain that the label design is correct and the label preview shows the correct 
values from the database, you can start sending the labels to the printer.  
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To print a label, do the following: 

1. In the Standard Toolbar, click the  button. 
The Print dialog box will open (same as the print preview dialog box). 

2. Click the Select Records button and select the records you want to print and specify 
the label quantity for each record.  

 
Selecting records and specifying label quantity 

3. Click the OK button. 

4. To start printing labels, click the Print button. 

5. To close the dialog box, click the Close button. 



ZebraDesigner Pro User Guide 

86 

Using Text File Wizard 

Text File Wizard 

When the input database file is a plain ASCII text file or formatted CSV (Comma Separated 
Values), Text File Wizard will be started within Database Wizard and it will guide you 
through the steps of text data acquire. The main difference between a real database and a text 
file is in their data structure information. Databases include all information about their fields 
(names, data format, and length) and can be automatically used with the application. Text 
files, on the other hand, do not have such information, and you will have to instruct the 
application on how the data is encoded. 

When the Text File Wizard finishes, it will return control to the Database Wizard that will 
guide you the rest of the way. 

Choose a Data Type 

Before you can use text file, you will have to define its data structure. Fields can be delimited 
by a separator (tab, semicolon, comma, or some entirely user-defined separator) or can be of a 
fixed length. 

 
Database Wizard –Choosing Data Type 

Choose Delimited, if you know that data fields are separated with a special character. File 
preview at the bottom of the dialog box can be helpful if you do not know exactly how the 
data is organized. 

Choose Fixed if you know that your data fields always occupy the same number of 
characters. 
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Start import at row option is useful when you do not want to import some rows at the top of 
the file. You may want to use this option when the text file contains a header on top of actual 
data fields. 

Set the Fields 

 
Database Wizard –Setting separator and delimiter 

In the second step of the Text File Wizard, you have to set the fields in the text file. If you 
have selected Delimited in the previous step, choose the appropriate separator here. 
Commonly, used separators are already pre-defined. But if you require some other, there is an 
option to use a custom-defined one. 

You can also select the Delimiter character that is used when a separator character is used in 
the text field itself. The delimiter should be used to enclose this field. Text between two 
delimiter characters is treated as one field although it contains the field separator character. 

The data preview in the bottom part of the dialog box will let you know if your choice of a 
separator character is a correct one. Fields will be separated with vertical lines if a separator is 
valid. 

If you selected to have your data formatted with fixed widths, the second step of the Wizard 
will be slightly different. Instead of selecting a character for field separation, you will have to 
define field widths. Use a mouse and draw a vertical line to the start positions of the fields. 
Lines will indicate where the new field starts. 
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Format the Fields 

 
Database Wizard –Formatting the fields 

In this step of the Wizard, you can review the field names and lengths. If necessary, you can 
modify them. You may use more recognizable field names so you can distinguish between 
them more easily. 

When you are finished with Text File Wizard, the structure information of the used text file is 
stored to a separate file with an extension of .SCH (Scheme File). If you try to use the same 
text file on a different label, you will not have to recreate the structure. SCH files will be 
automatically used and the Text File Wizard will not be necessary. 
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Using Printer Real Time Clock (RTC) 

When the printer selected on the label has a built-in Real Time Clock (RTC), you can use the 
time or date fields from the Real Time Clock with text objects on the label. The available time 
and date formats are defined in the printer driver. 

To use the time field from the printer RTC on the label, do the following: 

1. In the Toolbox, click the Text button. 

2. Click the position on the label, where you want to place the object. 
Text Wizard dialog box will open. 

3. Enable the Variable text option. 

4. Click the Next button. 

5. Select the Time Field option. 

6. Click the Next button. 

7. Enable the option Use the printer's internal clock. 

8. Select the appropriate time format from the list. 

9. Click the Finish button. 

Note: When you are using a prefix and suffix with the Real Time Clock field on the 
label, make sure that the length of the prefix and suffix does not exceed 31 characters. 
When you are using a linked field and are merging a Real Time Clock field with other 
fields, make sure that the length of fields surrounding Real Time Clock field does not 
exceed 31 characters. 
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Available Date Formats 

The date fields can be printed in various formats. In this field, you define how the date will 
look. You can select some of the predefined date formats or enter you own. When defining 
the formats, the following notation is used: 

D Number of the day in a month. Can occupy one or two characters. 

DD Number of the day in a month. Always occupies two characters (leading 
zeros will be added as necessary). 

M M is number of the month. Can occupy one or two characters. 

MM MM is number of the month. Always occupies two characters. 

YY or 
YYYY 

The year as 2 or 4 digits. 

DDD Abbreviation of the day of the week. 

DDDD The full name of the day of the week. 

MMMM The full name of the month. 

MMM The abbreviation of the name of the month. 

J The number of days since January 1. Can occupy from one to three 
characters. 

JJJ The number of days since January 1. Always occupies three characters. 

W The week number in the current year. Can occupy one or two characters. 

WW The week number in the current year. Always occupies two characters. 

 Any other sequence of characters will be displayed unchanged so you can 
insert dots, commas and other characters needed to properly write the date. 
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The examples: 

Format How the date will look 

D/M/YYYY 10/3/2005 

DD/MM/YY 10/03/05 

DDDD, D. MMMM YYYY Thursday, 10. March 2005 

JJJWWYYYY 069102005 

Available Time Formats 

The time can be printed in various formats. In this field, you define how the time will look. 
You can select some of the predefined time formats or enter you own. When defining the 
formats, the following notation is used: 

h Hours in 12-hour format (AM/PM will be added if they follow the time). Can 
occupy one or two characters. 

hh Hours in 12-hour format (AM/PM will be added if they follow the time). Always 
occupies two characters. (leading zeros will be added as necessary). 

H Hours in 24-hour format. Can occupy one or two characters. 

HH Hours in 24-hour format. Always occupies two characters. 

mm Used for minutes. 

ss Used for seconds. 

 

The examples: 

Format How the time will look 

h:mm {AM/PM} 8:25PM 

H:mm 20:25 

hh:mm:ss 08:25:36 
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Using Contents Mask 

The contents mask is very useful when you must display the input data differently on the 
label. With contents mask, you can reformat the data to suit your needs. Contents Mask is 
available in the Human Readable tab in bar code properties. 

The mask character will be replaced by the actual data and any other used character will be 
used as-is. If the current bar code value is 

"AD951" 

and the contents mask is 

"**C - ** /*/" 

the resulting output will be 

"ADC - 95 /1/" 

Powerful formatting structures can be defined using Contents mask, but it is only available 
with bar codes that allow custom formatting of the human interpretation. You should also 
make sure to print bar codes as graphics; otherwise, the contents mask is not available. 

Note: If your data contains the asterisk "*" character, then you will have to change the 
default mask character to something else. It should be a unique value, not appearing 
anywhere in the data. 
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Printing and Previewing Labels 

Preview Pictures 
When you place a picture on the label, in design mode it is always shown in color-depth as 
defined in the picture. 

However, when previewing the labels on-screen, the preview of the pictures depends on the 
dithering option set in the printer driver. All color pictures (except WMF and EMF files) are 
converted to monochrome images. The illusion of colors and shades of grey is accomplished 
by varying the pattern of dots. More dots close together will provide a darker shade of grey. 

The preview of the label will show pictures in the same way as they will be printed according 
to the dithering setting. A more accurate print preview is guaranteed this way. 

If the picture is not previewed as you would like to print it, change the dithering setting in the 
printer driver. 

Preview and Print a Label 
If you want to print a label, you can use the print preview to simulate a print output. The label 
preview shows the label on the screen. 

Simulate printing 10 labels on the screen to check label layout and printing procedure. 

1. In the Standard Toolbar click the  button or from the File menu select 
the Print command. 
The Print dialog box appears. 

2. Enter 10 for Label Quantity and click on the Preview button.  
ZebraDesigner Pro will close the dialog box and simulate the production for 10 labels 
on the screen. 

Note: You can select between the quantity of the labels and the quantity of pages. The 
page can have one or more labels, and the labels are arranged on the page in columns 
and rows. If you have eight labels on the page, quantity of ten pages will print 80 labels. 

When you are certain that the labels will be printed correctly and the preview shows the 
correct values, you can proceed to real printing. To actually print the labels, do the following: 

1. In the Standard Toolbar, click the  button.  
The Print dialog box appears. 

2. Enter 10 for the Label Quantity and click the Print button.  
Your printer will now print 10 labels. 
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Optimize the Printing Speed 
There are many factors that affect the printing speed. By following the guidelines below you 
can dramatically increase the speed of printing: 

• If your printer supports parallel and serial ports, use the parallel port. Your computer 
can send data to the printer over a parallel port much faster than over serial port. 

• Use the printer's internal fonts instead of Windows' true-type fonts. True-type fonts 
must be sent to the printer as graphics and the size of the file is much bigger 
(kilobytes). When using internal fonts, only the text is sent to the printer (couple of 
bytes). If you must use true-type fonts, use the Font Downloader program, to 
download these fonts to the printer's memory and access these fonts as internal printer 
fonts (only if your printer supports this). 

• When using bar codes, make sure that you do not print bar codes as graphics if your 
printer supports printing bar codes. 

• When using counters, the printer will internally increment the numbers if the internal 
fonts are used (if supported by the printer). This means, that the printer will receive 
only the first number of objects, and will later increment this number to print other 
labels. Using this option also reduces the amount of data transferred between 
computer and printer, but the difference is noticeable only with high quantities of 
labels. 

• Set the printing speed to a higher value (if your printer supports it). Note that setting 
the printing speed usually affects the quality of printing. The higher the speed, the 
lower the quality. You will have to find an acceptable compromise for this. 

• Don't print too much data on labels. If the speed of printing is an important factor, you 
should consider using preprinted labels, and print only the data, that is different on 
each label. 
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Technical Support 

Online Support 
You can find the latest builds, updates, workarounds for problems and Frequently Asked 
Questions (FAQ) under the Support section on the Zebra Web site. If you cannot solve the 
problem on your own, please contact your local vendor or representative offices listed in the 
topic Contact Information. 

Contact Information 
Worldwide, Technical Support is available through your Reseller, or at: 
http://www.zebra.com/support. 

 

Zebra Technologies Corporation 
International Headquarters 
333 Corporate Woods Parkway 
Vernon Hills, Illinois 60061-3109 USA 

Phone: +1 847 913 2259 
Fax: +1 847 913 2578 
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Glossary of Terms 

Auto translation 

Bar code interpretation in human readable characters. 

Darkness 

The print-head temperature defines the print darkness. The higher is the temperature, the 
darker is the printout. (thermal printers only) 

Descender bars 

Longer first and last bar in the EAN 13 bar codes. 

Quiet zone 

The empty place before and after the bar code symbol. This is necessary for the bar code 
reader to properly read the bar code. 

Security 

The definition of the control check-digit with some bar code types. 
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